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Lesson 1 – Course Overview 

Introduction 

This course covers the skills required to use the inmydata dashboard 
designer to create and publish dashboards 

Audience 

The course is intended for end users who will create and publish dashboards 
to the inmydata platform 

Prerequisites 

Users should be familiar with the concepts of dashboard design and data 
visualisation.  
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Student Goals 

Please take a few moments to document your own goals for this course. 
What will you need to know and/or produce when you return to work? 
 
What are the three things you most want to know about building dashboards 
with inmydata? 
 

•    
 
 

•    
 
 

•    
 
 

Please introduce yourself by answering the following questions 
 

1. Your Name and Job 
 
 

2. Your experience with inmydata or any other analytics tool 
 
 

3. What you would like to learn from this course 
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Course Goals 

 
When you complete this course you should be able to: 
 

Download and install the dashboard designer 
Understand and work with the dashboard designer interface 
Create and new dashboard and manage tabs 
Add visualisation objects to your dashboard 
Add filters and control panels to your dashboard 
Publish, save and mange dashboards 
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Lesson Overview 

Lesson What is covers 

Lesson 1 - Course 
Overview 

Introductory material about this course 

Lesson 2 – Downloading 
and installing the 
dashboard designer 

Covers how to download the dashboard 
designer installation package from your 
inmydata tenant, and how to install it on your 
local machine.  

Lesson 3 – Working with 
the dashboard designer 
interface 

A detailed look at the different elements in 
the dashboard designer interface. 

Lesson 4 – Creating or 
opening a dashboard and 
managing tabs 

A detailed look at how to open or create a 
dashboard and manage tabs that will contain 
the content in that dashboard. 

Lesson 5 – Adding data 
visualisations to your 
dashboard. 

A detailed look at what visualisation objects 
are available in inmydata dashboards, and 
how to add them to your dashboard. 

Lesson 6 – Adding control 

panels and filtering data in 
your dashboard 

A detailed look at adding control panels and 

filtering data in your dashboards.  

Lesson 7 – Publishing, 
saving and managing 
dashboards 

A detailed look at publishing a dashboard to 
the inmydata platform, saving locally and 
managing existing dashboards.  

Appendix A – Year on year 
comparisons with 
summary calculations and 
calendar variables 

A detailed look at using summary 
calculations and calendar variables to 
produce dashboards for year on year 
comparisons 
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Lesson 2 – Downloading and installing the dashboard 
designer 

Introduction 

The inmydata dashboard designer is a Microsoft Windows desktop 
application. You must download and install the application on your PC to 
create and publish dashboards. In this lesson,   ’                          
download and install the application, how to install it, and steps to open the 
dashboard designer for the first time.   

Learning Objectives 

When you complete this lesson you should be able to: 
 

• Check your PC is compatible with the dashboard designer 

• Download the dashboard designer 

• Install the dashboard designer 

• Open and run the dashboard designer 
 

Prerequisites 

Before you begin this lesson you should be able to: 
 

• Understand how to use a Microsoft Windows desktop PC 
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Before you install 

The inmydata client applications must be downloaded and installed on PC. 
Before you do so, check that the PC you intend to use matches the minimum 
requirements available here. 
  

                  

https://support.inmydata.com/support/solutions/articles/36000325559-what-are-the-minimum-requirements-to-install-inmydata-client-applications-on-my-machine-
https://support.inmydata.com/support/solutions/articles/36000325559-what-are-the-minimum-requirements-to-install-inmydata-client-applications-on-my-machine-
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Downloading the installer 

The inmydata client applications installation package can be downloaded as 
follows. 
 

1. Log in to your inmydata tenant 
2. Click the + icon to create a new visualisation 

  
3. Click on the link to download the installer 
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Installing the inmydata client applications 

To install the inmydata client applications, do the following. 
 

1. Double click on the installation package that was downloaded, or 
select Open from the browser you downloaded it with. 

2. Answer Yes to the security question when prompted if you want to 
allow this application to make changes to your device.  

3. Select Next on each step of the wizard, until you are offered the 
Install button. 

4. Press Install and complete the wizard.  
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Starting the dashboard designer 

To start the dashboard designer, follow these steps. 
 

1. Double click on the inmydata dashboard designer shortcut on the 
desktop or the start menu. 

2. If this is the first time you have used the dashboard designer on this 
machine, enter the name of the tenant you wish to connect to when 
prompted, and press OK. 

3. Login when prompted. 
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Lesson 3 – Working with the dashboard designer interface 

Introduction 

In this lesson you will learn about the inmydata dashboard designer 
interface, and be familiarised with the various components that you will use 
when building dashboards.  

Learning Objectives 

When you complete this lesson you should be able to: 
 

• Understand and work with the different components of the inmydata 
dashboard designer interface 

 

Prerequisites 

Before you begin this lesson you should be able to: 

• Install the inmydata client applications. 

• Open the dashboard designer. 
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The dashboard designer Interface 

The inmydata dashboard designer interface comprises a number of key 
elements that allow you to view and modify dashboards. The interface 
includes docking functionality that allows the size and position of each of 
these elements to be modified depending on the type of the element. The 
different elements are listed below, along with their type, and the docking 
functionality is explained thereafter.  
 

Element Type Description 
Ribbon Fixed 

Object 
The ribbon is the primary interface to access functionality in 
the inmydata dashboard designer. It can be hidden, but its 
position cannot be changed from the top edge of the window. 

Work Area Fixed 
Object 

The Work Area is used to render the currently open 
dashboard. It cannot be explicitly moved or resized, but it will 
take all the remaining space below the ribbon once the 
docking windows and status bar have been rendered. 

Tabs Fixed 
Object 

The tabs represent the different tabs in the open dashboard. 
The size and position of the tabs are fixed by the work area, 
however you can re-order the tabs by dragging them.  

Support 
Window 

Docking 
Window 

The support window is a docking window. This means its size 
and position can be modified using the docking interface 
described below. The window gives you easy access to the 
inmydata support website. 

Toolkit Docking 
Window 

The toolkit window is a docking window. This means its size 
and position can be modified using the docking interface 
described below. 

Status Bar Fixed 
Object 

The status bar is a fixed information panel at the bottom of 
the inmydata dashboard designer window. It can be shown or 
hidden by selecting the Hide the status bar button on the 
Application Settings tab of the ribbon. 
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Using the Ribbon 

The Ribbon is designed to help you quickly find the commands that you need to 

complete a task. Commands are organized in logical groups, which are collected 

together under tabs. Each tab relates to a type of activity, such editing a dashboard or 

managing application settings. 

  

Minimizing the ribbon 

1. Click Customize Quick Access Toolbar . 
2. In the list, click Minimize the Ribbon. 
3. To use the Ribbon while it is minimized, click the tab you want to use, 

and then click the option or command you want to use. 
For example, with the Ribbon minimized, you can select an object in 
your dashboard, click the Edit Dashboard tab, and then in the 
DashboardObjects group, click the edit button. When the Dashboard 
Object Definition dialog opens, the ribbon is once again minimized. 

As an alternative, you can double click on a tab in the ribbon, check the 
Minimize the Ribbon button in the Appearance Group of the Application 
Settings tab or press the minimize button  on the right hand side of the 
ribbon to minimize it. 
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Restoring the ribbon 

1. Click Customize Quick Access Toolbar . 
2. In the list, click Minimize the Ribbon. 

As an alternative, you can double click on a tab in the ribbon, uncheck the 
Minimize the Ribbon button in the Appearance Group of the Application 
Settings tab or press the maximize button  on the right hand side of the 
ribbon to restore it. 

The Quick Access Toolbar 

The Quick Access Toolbar is a customizable toolbar that contains a set of 
commands that are independent of the tab currently displayed. You can 
move the Quick Access Toolbar from one of the two possible locations, and 
you can add buttons that represent commands to the Quick Access Toolbar. 

Configuring the commands on the Quick Access Toolbar 

To add or remove commands from the Quick Access Toolbar, follow these 
steps: 

1. Click Customize Quick Access Toolbar  at the far top right of the 
Window. 

2. In the list, click the item that represents the command you wish to 
add or remove from the Quick Access Toolbar. 

Moving the Quick Access Toolbar 

The Quick Access Toolbar can be located in one of two places: 
 

Upper left corner, above the Ribbon (default location) 
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Below the Ribbon 
 

 
 
 Follow these steps to move the Quick Access Toolbar to the other of the two 
places: 

1. Click Customize Quick Access Toolbar . 
2. In the list, click on Show Below the Ribbon or Show Above the Ribbon. 
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The Docking Interface 

The inmydata dashboard designer interface contains two types of objects, 
fixed objects and docking windows. You can adjust the viewing and editing 
space for the dashboard depending on how you arrange the windows in the 
Interface. The following options are just some of the ways windows can be 
arranged: 
 
1. Dock docking windows to the edge of a frame in the Interface 
2. Float docking windows over or outside the Interface. 
3. Minimize docking windows along the edge of the Interface. 
4. Hide docking windows altogether. 
5. Reset docking window placement to the default layout. 

 
Docking windows can be arranged by dragging, using commands on the 
ribbon and by right clicking the title bar of the window to be arranged.  

Floating Windows 

Any docking window can be undocked from the Interface and moved 
anywhere on the desktop. You can undock a docking window from the 
Interface in two different ways: 
 
Method 1 

1. Press and hold the left mouse button over the title bar of the docked 
window. 

2. Drag the window to a free area of the desktop. 
3. Release the left mouse button 

 
Method 2 

1. Double click the left mouse button over the title bar of a docked 
window. 
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Auto Hiding Windows 

Docking windows support a feature called Auto Hide. Auto Hide causes a 
window to slide out of the way when you use a different window. When a 
window is Auto Hidden, its name is displayed on a tab at the edge of the 
Interface. To use the window, move the mouse over the tab so that it slides 
into view. By default, any data viewer windows will be auto-hidden at the 
bottom of the Interface.  
 
To turn Auto Hide on 

1. Press the right mouse button on the title bar of the window you want 
to hide to open the context menu. 

2. Select Auto Hide. 
As an alternative, you can click the pushpin icon on the title bar of the 
window. 
 
To turn Auto Hide off 

1. Press the right mouse button on the title bar of the window you want 
to hide to open the context menu. 

2. Select Dock. 
As an alternative, you can click the pushpin icon on the title bar of the 
window. 

Docking Windows 

You can dock any docking window relative to the Interface, Work Area or 
another window. The 

Interface displays guide 
icons that appear when 
you start dragging a 
docking window. 
 
The guide icon in the 
centre of the image on 
the right allows you to 
dock a window above, to 
the left, to the right and 
below the work area. 
 
The guide icons around 
the edges of the image 
on the right allow you to 
dock a window on each 
edge of the Interface.  
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When you drag a 
docking window over 
another docking 
window, the guide icon 
in the centre of the 
image on the right 
appears. 
 
This guide icon allows 
you to dock the window 
above or below, or to 
the left or right of the 
window. It also gives 
the option to stack the 

docking windows, giving a single tabbed docking window. 
 
To dock windows in the Interface, follow these steps: 
 

1. Click and hold the left mouse button over the title bar of a non Auto 
Hidden docking window. 

2. Drag the window until an appropriate guide icon appears, then 
continue dragging until the mouse is over the appropriate guide icon. 

3. Release the mouse button. 
 

Hiding Docking Windows 

If you are short of space on your desktop, you can hide docking windows 
altogether and re-establish them when required. 
 
Follow these steps to hide docking windows: 
 

1. Select the Show/Hide button from the 
Application Settings tab on the ribbon. 

2. Uncheck the menu item that relates to the 
window you wish to hide, or press Hide All to 
hide all docking windows. 

 
As an alternative, you can press the close icon in 
the top right corner or the docking window. 
 
To re-establish a window that has previously been 
hidden, follow these steps: 
 

1. Select the Show/Hide button from the Application Settings tab on the 
ribbon. 

2. Check the menu item that relates to the window you wish to hide, or 
press Show All to show all docking windows. 
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Resetting the default docking layout 

To reset the default docking layout, follow these steps: 
 

1. Press the Restore Defaults button from the Application Settings tab on 
the ribbon. 
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Lesson 4 – Creating or opening a dashboard and managing 
tabs 

Introduction 

In this lesson you will learn how to open an existing dashboard, or create a 
new one. You will also learn how to manage tabs in a dashboard.  

Learning Objectives 

When you complete this lesson you should be able to: 
 

• Open an existing dashboard from disk. 

• Open an existing dashboard from the server. 

• Create a new dashboard. 

• Add tabs to a dashboard. 

• Delete tabs from a dashboard. 

• Rename tabs. 

• Delete tabs. 
 

Prerequisites 

Before you begin this lesson you should be able to: 

• Install the inmydata client applications. 

• Open the dashboard designer. 

• Understand the dashboard designer interface. 
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Opening a Dashboard 

Dashboards opened from two different places.  
 
To create a dashboard, follow these steps: 
 

• Select Create New Dashboard from the File menu of inmydata 
dashboard designer. 

 
To open a dashboard that has been saved locally to disk, follow these steps: 
 

• Select Open From File from the File menu of inmydata dashboard 
designer. 

• Select the dashboard file you wish to open and press ok.  
 

To open a dashboard that has been published, follow these steps: 
 

• Select Open From Server from the File menu of inmydata dashboard 
designer. 

• Select the dashboard file you wish to open and press ok.  
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Working with Tabs 

A dashboard is a visual display of the most important information that a user 
needs. The information is consolidated and arranged on a single screen so 
that it can be monitored at a glance. 
 
However, it is not unusual to want a single dashboard to convey a number of 
different types of information. As such, a single dashboard can contain 
several screens, allowing the user navigating between these screens using 
tabs.  
 
When you first create a new dashboard, inmydata creates a single tab. The 
Dashboard Tabs group in the Edit Dashboard tab on the Ribbon allows you to 
add, remove and change the name tabs in the dashboard. You can re-order 
tabs by dragging them. 

Adding a new tab to the Dashboard 

To add a new tab to your dashboard, follow these steps: 
 

1. Press the New command in the Dashboard Tabs group in the Edit 
Dashboard tab of the Ribbon. 

 

Deleting a tab from the dashboard 

To delete a tab from the dashboard, follow these steps: 
 

2. Select the tab. 
3. Press the Delete command in the Dashboard Tabs group in the Edit 

Dashboard tab of the Ribbon. 
4. Press Yes in the message box. 
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Changing the tab title 

To change the title of a tab, follow these steps: 
 

1. Select the tab. 
2. Press the Change Tab Title command in the Dashboard Tabs group in 

the Edit Dashboard tab of the Ribbon. 
3. Enter the new title for the tab 
4. Press OK. 

 
As an alternative, you can edit the tab title directly in the tab selection list in 
the Dashboard Tabs group of the Edit Dashboard tab in the Ribbon. 

 

Changing the tab order 

To change the tab order, follow these steps: 
 

1. Press and hold the left mouse button over the header of the tab you 
wish to move. 

2. Drag the tab into the position you require. 
3. Release the left mouse button. 
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Lesson 5 – Adding data visualisations to your dashboard 

Introduction 

In this lesson you will learn what data visualisation objects are available in 
inmydata dashboards, and how to add and edit them. 

Learning Objectives 

When you complete this lesson you should be able to: 
 

• Understand the different visualisation types available in a dashboard. 

• Add different visualisations to a dashboard. 

• Edit visualisations on a dashboard. 
 

Prerequisites 

Before you begin this lesson you should be able to: 

• Install the inmydata client applications. 

• Open the dashboard designer. 

• Understand the dashboard designer interface. 

• Create and open dashboards. 
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Managing dashboard objects 

Dashboard objects are the objects that provide the visual display and 
control elements of the dashboard. The objects can be grouped into five 
broad categories, each of which is described in the following sections. 

Data and Control Objects 

The Data and Control objects contain data listing and control objects which 
allow you to filter the data on the dashboard.  
 
The control panel is a container object for labels, query parameters, filter 
parameters, images and refresh buttons. The control panel will be described 
in detail later in this lesson.  
 
The tree view selection panel allows the user to apply complex filtering to a 
dashboard using a simple tree view interface. The tree view selection panel 
will be described in detail later in this lesson.  
 
The pivot table is a tabular representation of data that can automatically 
sort, count, total or give the average of data quickly creating unweighted 
cross tabulations. The pivot table will be described in detail later in this 
lesson.  
 
The data grid allows you to display a simple listing of data in a dashboard. It 
also gives the user the ability to group, summarise and sort the data. The 
data grid will be described in more detail later in this lesson.  
 

Single Series Charts 

Single series charts are charts that display data visually by mapping a single 
set of textual values (series) against a single numeric value.  
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This is in the form of a circular area chart (pie and doughnut charts).  
 
Use this type of chart when you are interested in the value of a single 
variable across a single group. Two examples might be plotting the value of 
sales by sales representative, or the value of sales each month this year. 
 

Multi Series Charts 

Multi series charts are charts that display data visually by mapping one or 
more sets of textual values (series) against one or more numeric values. This 
is in the form of a two dimensional chart where the numeric values are 
plotted on a y axis against the textual values on the x axis.  
 
Use this type of chart when you are interested in the value of one or more 
variables across one or more groups. One example might be plotting the 
values of sales and the value discounted by sales representative. Another 
might be plotting the value of orders shipped, and the value of orders 
delivered in each month this year. 

Stacked Charts 

Stacked charts are a variation on multi-series charts that display data 
visually by mapping one or more sets of textual values (series) against one 
or more numeric values. This is in the form of a two dimensional chart where 
the numeric values are plotted on a y axis against the stacked textual values 
on the x axis, giving not only an indication of the individual values for each 
series, but also an indication of the summed values across all series.  
 
Use this type of chart when you are interested in the value of one or more 
variables across one or more groups, but also wish to see the summed total 
of the different values. One example might be plotting the total order value 
for each month, but seeing the total order value broken down by the order 
status. 

Combination Charts 

Combination charts are a variation of multi-series charts and stacked charts 
that allow different types of values to be displayed on a single chart. The 
different types of values can be differentiated by giving them a different 
visual appearance, for instance displaying them as a column, line or area. In 
addition, different values that have a significantly different scale can be 
plotted on a second Y axis, allowing them to be scaled independently to fit 
neatly on to the chart.  
 
A good example of a combination chart might be to plot the value of orders 
and quantity ordered each month.  
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Scroll Charts 

Scroll charts are a variation on single series, multi-series, stacked and 
combination charts that cater for a large number of series values by scrolling 
or allowing zooming. 

Spark Charts 

Spark charts allow you to plot a single value against one dimension, for a 
range of group values. The charts are designed to give a quick and visual 
indication of how a value is trending for each group value. For instance, you 
may use a spark chart to give a quick visual representation of how sales are 
trending in several stores.  

Gauges 

Gauges are objects that show a single value. Gauges are useful when you 
have a single value that you want to be measured quickly against a 
particular range. Some gauges will allow you to show the value against a 
number of coloured ranges (such as a traffic light or dial), and others will 
allow you to show the value only against a total range (such as a cylinder or 
thermometer).  
A good example of when a gauge may be useful is to show the total ordered 
value against the target, for a specific month or year. 

Adding dashboard objects to your Dashboard 

You can add dashboard objects to your dashboard in one of two ways, by 
dragging the required object from the Toolkit docking window or by 
selecting the required object from the Add button of the Dashboard Objects 
group of the Edit Dashboard tab on the ribbon. Both these methods are 
described in more details below. 

Adding dashboard objects from the toolkit 

Using the toolkit to drag a new object on to the dashboard has the 
advantage of allowing you to decide where the new object is placed in the 
tab, relative to the other objects already present. To add an object by 
dragging it from the toolkit, follow these steps: 
 

1. Press and hold the left mouse button over the appropriate object in 
the Toolkit docking window. 

2. Move the mouse until it is over the guide icon that represents the 
location you want to place the new object (the guide icons are 
explained in more detail below). 

3. Release the left mouse button. 
4. Define the details of the dashboard object in the Dashboard Object 

Definition dialog box (explained in more details below). 
 
When you are dragging a new dashboard object on to the chart, the mouse 

cursor will change to the chart dragging cursor ( ). As you drag the mouse 
over the tab, two types of guide icon will appear. 



inmydata – creating dashboards 

 27 

 
Guide icons around the 
edge of the tab allow 
you to place the new 
dashboard object 
against the left, top, 
right or bottom edge of 
the tab. 

 
 
When you drag the 
mouse over an existing 
object in the dashboard, 
guide icons appear that 
allow you to drop the 
new object to the left, 
top, right, bottom of the 
existing object, or 
stacked on top of the 
existing object. If objects 
are stacked, tabs will 
appear to allow the user 
to display each object. 
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Adding dashboard objects from the ribbon 

Using the Add button of the Dashboard Objects group of the Edit Dashboard 
tab on the ribbon to add objects to the dashboard has the advantage of 
allowing you to select the object type from an ordered list of objects. To use 
the ribbon to add a dashboard object to the dashboard, follow these steps:  
 

1. Press the Add button in the Dashboard Objects group in the Edit 
Dashboard tab in the ribbon. 

2. Select the type of object you wish to add to your dashboard from the 
list. 

3. Define the details of the dashboard object in the Dashboard Object 
Definition dialog box (explained in more details below). 

Defining the details of objects in the dashboard 

The Dashboard Object Definition window allows you to specify the 
appearance and behaviour of dashboard objects that have been added to 
your dashboard tabs. The window is opened when you add a new dashboard 
object to your dashboard, or select the Edit button in the Dashboard Objects 
group in the Edit Dashboard tab in the ribbon. The table below gives an 
overview of the different tabs in the window, which will be described in 
more detail below: 
 

Tab Description 

Data  Allows you to define the data that 
will populate the dashboard object. 

 Appearance Allows you to specify settings that 
will govern the appearance of the 
dashboard object. 

 Numeric Format  Allows you to specify the numeric 
format used to display numbers in 
the dashboard object. 

X Axis  Allows you to specify settings that 
govern the appearance of the X axis 
on the dashboard object. 

 Y Axis Allows you to specify settings that 
govern the appearance of the Y axis 
on the dashboard object. 

Drill Down Allows you to add and define a drill 
down to the dashboard object 

 Advanced Allows you to add advanced XML 
definitions to your dashboard 
object. 
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Defining data for a dashboard object 

Follow the steps below to specify the data; 
 
1. First select the Query data set that you wish to base your dashboard 

object; 

 
2. Select the calendar you wish to be used to derive any date groupings 

(such as year, period, week etc).   
3. If you wish to, press the filter button to apply a filter to your data set 

(applying filters will be described in more detail below).  
4. Next, decide how you want to group your data, and select the 

appropriate option; 

    
The three options are 

a. On Change of:  
Create a record for each distinct combination of the 
group values selected. 

b. For All Records:  
Creates a single record regardless of the group values 
selected. 

5. Add the group columns ( ) you require (some object types, such as 
single series charts, will only allow a single group column). 

6. Next, select which summary columns ( ) you require (some object 
types, such as single series charts, will only allow a single summary 
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column).  

  
7. For each summary column, select the summary operation you wish to be 

applied. Distinct count is the number of distinct values in the column for 
the group selected. Some summary columns will be calculations, rather 
than values that exist in the dataset. For these columns, the only 
summary operation  

Managing group options 

The group options dialog allows you to manage how groups are collated and 
sorted. To open the Group Options dialog box, follow these steps: 
 
1. Select the group you want to manage in the Data tab of the object 

definition dialog. 
2. Press the Group Options button. 

  
Once the Group Options dialog is open, you can change the group you are 
managing by selecting the appropriate value in the Group dialog box. 

  

Managing how groups displayed 

For multi-series charts, such as line charts or column charts, you can select 
whether a group is a category or a graph. A category is used to build the 
groups that are plotted along the main axis (usually the x axis). A graph is 
display as a separate element in the chart, for instance a separate line or 
column.  

Managing how groups are collated 
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The Group Selection tab in the Group Options window allows you control 
how group values are collated. This can change the number and value of the 
groups created. If your group value is a date, or date-time value, you can 
choose which time interval is used to create your group. Follow these steps 
to define data and date-time groups: 
 

Select the time interval you want the group to be created from. 

  
 

Often, there may be too many group values to fit comfortably on the chart, 
and you may only be interested in the groups that have either the largest or 
smallest values. To resolve this, you can limit the number of group value 

using one of the group limiting options. The table below describes each of 
these group limiting options: 

Group limiting 
option 

Description 

All Shows all groups 

Top N Shows a specified number of groups with the 
highest summary value.  

Bottom N Shows a specified number of groups with the 
lowest summary value. 

Top Percentage Shows groups where a specified summary value is 
in the top percentage specified. 

Bottom Percentage Shows groups where a specified summary value is 
in the bottom percentage specified. 

 
To apply one of the group filtering options, follow these steps: 
 
1. Select one of the group limiting option (top n, bottom n, top percentage, 

bottom percentage)  
2. Select the summary column that will be used as the value to determine 

the top or bottom values. 
3. Enter a value for the number of groups (N) or percentage.  
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4. If you want to include all other groups summarised into a single group 
on the chart, select Include Others and enter a label for the extra group.  

5. If you want to include ties, select the include ties option. For instance, if 
you select top N, where N is 5, and the values of group 5 and 6 are 
identical, the chart will include 6 groups. 

  

Managing the sort order of Groups 

The Group Sorting tab in the Group Options window allows you to define the 
order in which the groups are shown in the dashboard object. You can sort 
each group based on the group value, or one of the summary values. Follow 
these steps to define the sort order: 

1. First, select which column the group sorting is going to be based on. 
This may be the same column that the group itself is based on, or a 
summary column. 

2. Select how you want the sort column value to be applied to sort the 
group. The options are described in the table below:  

Option Description 

Ascending Groups will be sorted in ascending 
order using the value of the column 
selected. 

Descending Groups will be sorted in descending 
order using the value of the column 
selected. 

Original Order Groups will be sorted in the original 
order the data is returned by the 
query. 

 
  
Once you have defined a specified order, you can change the order by 
dragging the columns up or down in the list. 
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Defining the appearance of your dashboard object 

The Dashboard Object Definition window Appearance tab allows you to 
specify settings that will govern the appearance of the dashboard object.  
To define the appearance of objects on your dashboard, follow these steps: 
 
1. Select the type of chart or legend you wish to display. 
2. Enter a title and second title (the second title will appear on a second 

line). 
3. Select if you want point labels on the chart, whether those labels should 

(if possible) be drawn inside the chart, whether they should be shown 
with vertical text, whether to show a legend on the chart. 

 
4. For line and area charts, you can select whether the chart should use 

spline calculations to smooth the line between the points, or if not 
selected, simply draw a straight line between the points.   

5. Line and area charts will also let you define how to handle zero values. 
The options are described below: 

Option Description 

Plot Zero Values All data points will be plotted.  

Do not plot leading zero 

values 

Any zero values not preceded by a 

non-zero value will be ignored. This 
prevents datasets with leading zero 
values being plotted with lines that 
start anchored to the X Axis. 

Do not plot any zero values Any zero values will not be plotted. 

Hide groups with zero 
values 

Any groups that contain one or 
more zero values will not be 
plotted.  

 
6. For certain chart types, you can also select whether to display a series as 

a line, bar or area, and if the object type has a dual Y axis, which Y axis to 
display the series on. 
Dual Y Axis charts 
allow you to 
display multiple 
values with very 
different scales 
on a single chart.  
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Defining the numeric format for dashboard objects 

The numeric format tab of the dashboard object definition screen allows you 
to specify the numeric format of numeric values in a data grid, and the point 
labels and (if they have not been defined separately) the labels on the Y axis 
of your charts. Follow these steps to define the numeric format for the 
dashboard object: 
 
1. If you are configuring a dashboard object with a dual Y axis, you can 

specify a different numeric format for each Y axis. As such, you need to 
select which Y axis you are specifying the details for. 

 
2. If you want to format the numeric values, select the format option. 
3. Select the maximum number of decimal places you want to show. 
4. Select whether you want to force trailing zero (for instance, the values 

are currency and you always want two values after the decimal point). 
5. Decide what scaling units to apply to your numeric values in a 

dashboard object. Scaling provides notation for large values, so for 
instance 1340 can be displayed as 1.34K, and 2345263 can be displayed 
as 2.35M. There are a number of scaling units pre-defined for you, 
however if these do not fit your requirements you can define your own. 

 
To define your own scaling units, select other from the scaling units list. 
Next supply a comer separated list for the scaling units and the scaling 
values. Each entry in the scaling units list will be displayed as a suffix to 
your values. Each entry in the scaling values represents the amount the 
value will be divided by from the previous scaling unit to achieve the 
display value.  
For instance, you could set your scaling units to 
"Thousands,Millions,Billions" and your scaling units to 
"1000,1000,1000". In this example, 1340 will be displayed as 
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1.34Thousands, and 2345263 will be displayed as 2.35Millions. 
If the scaling units list has one more entry than the scaling values, units 
will be given the first entry in the list as a suffix. For instance, for time 
scaling units, you could set your scaling units to 
"minutes,hours,days,weeks,years" and your scaling values to 
"60,24,7,52". 

6. If required, select a currency symbol (value that will be displayed before 
your numeric values). If the value you want is not in the list, select other 
and enter your desired value. You can also enter a number suffix, a 
string that will be displayed after numeric values. 
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Managing the X Axis for dashboard objects 

The Dashboard Object Definition window X Axis tab allows you to specify 
settings that govern the appearance of the X axis on the dashboard object. 
Follow the steps below to specify the X Axis details on your dashboard 
object; 
 
1. Enter a title for the X Axis. 
2. Select the orientation of the labels on the X Axis. 

 
3. If you wish to trim the length of the labels on the x axis, follow these 

steps; 
a. Check the checkbox labelled Limit the length of labels on 

the x axis 
b. Enter the maximum length of the label 
c. Select whether to trim extra characters from the start, or 

end of the label. 

 

Managing the Y Axis for dashboard objects. 

The Dashboard Object Definition window Y Axis tab allows you to specify 
settings that govern the appearance of the Y axis on the dashboard object. 
Follow the steps below to specify the Y Axis details on your dashboard 
object; 
 
1. If you are configuring a dashboard object with a dual Y axis, you can 

specify a configuration for each Y axis. As such, you need to select which 
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Y axis you are specifying the details for. 

 
2. Enter a title for your y axis. If you want, you can specify an alternative 

number of decimal places for this Y axis, that will override the value 
specified in the Numeric Format tab. 

3. If all the values to be plotted on a Y Axis are either positive, or all 
negative, by default the Y Axis will always have a minimum value (or 
maximum if all your values are negative) or zero. If all your values are 
well above (or well below) zero if might be sensible to uncheck the "fix 
minimum value as zero" option so it is easier to differentiate values 
plotted against your Y Axis. 
Alternatively, you can override that automatic calculation of the Y Axis 
range, by selecting that Y Axis values should be fixed, and specifying the 
minimum and maximum values. (NB. If the values in your chart cannot be 
plotted on the range you have given, the range will be extended to 
compensate). 
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Managing drill downs for your dashboard object 

A drill down allows the user to click on an area of a dashboard object, to 
open another display that shows more detail. Unless you specify otherwise, 
when the user clicks on an area of a dashboard object, they will be asked to 
select a dimension in the dataset the object uses (or a linked dataset). The 
platform will then generate a drill down based on the parent object, showing 
detail broken down by the dimension selected.  
 
You constrain the drill down functionality by defining a drill down path. 
Follow these steps to define a drill down path: 
 

1. Select the define a specific drill down path. If you select this option, 
and do not add any visualisations to the drill down path, the user will 
not be offered any drill down from this object. 

2. Press add to select an existing visualisation to add to the list. 
3. Repeat step 2 to complete the drill down path. 

 
 
Drill downs are only available once the dashboard has been published.  
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Adding tree view selection panels 

Tree View Selector Panels allow users to quickly apply complex hierarchical 
filtering to objects on a dashboard. Follow these steps to add a tree view 
filter panel to your dashboard: 
 

1. Drag a tree view panel from the toolkit on to your dashboard, or 
select Tree View Selection Panel from the list that appears when you 
press the Add button in the Dashboard Objects group of the Edit 
Dashboard tab. 

2. Define the tree view selection panel settings in the Tree View 
Selection Panel window (described in more detail below). 

Defining data for a tree view selection panel 

The Tree View Selection Panel window Data tab allows you to specify the 
data that will be used to display and build the filters for your tree view 
selection panel. Follow these steps to specify the values that will appear in 
the tree view: 
 
Follow the steps below to specify the data; 
 

1. First select the Query data set that you wish to base your treeview; 

 
2. Select the calendar you wish to be used to derive any date groupings 

(such as year, period, week etc).   
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3. If you wish to, press the filter button to apply a filter to your data set 
(applying filters will be described in more detail below).  

4. Select a column in the Available Columns list, and press the Add 
Column button to add the column as the root group item. 

5. Select a different column as the child filter column in the Available 
Columns list, and press the add child column button ( ). 

6. Repeat the steps above to add all the columns you require. 
7. If you wish to, you can change the way group values are grouped, 

sorted and displayed by selecting the group options button to open 
the group options window. 

Defining the appearance of a tree view selection panel 

The Tree View Selection Panel window Appearance tab allows you to specify 
settings that will govern the appearance of the tree view selection panel. 
Follow the steps below to specify the appearance of your dashboard object; 

1. Enter a title for your tree view selection panel. 
2. By default, nodes will remember their checked state when you 

publish a dashboard. However, if the underlying data changes, you 
can select whether new nodes are checked when added to the 
treeview.  

Defining which objects a tree view selection panel applies to 

The Tree View Selection Panel window Objects to filter tab allows you to 
specify which objects on your dashboard the panels filter will be applied to. 
 
The Objects to filter tab contains a root node for all tabs in your dashboard 
that contain at least one object that has the same columns as the tree view 
filter panel. Each root node contains a child node for each dashboard object 
in that tab that has the same columns as the tree view filter panel. 
 
Follow the steps below to apply the filter to objects on the dashboard; 
 

1. Select the node that represents the object. 
 
Alternatively, to select all the objects on a single tab, select node that 
represents the tab. 
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Adding a Pivot Table 

The Pivot Table editor window allows you to specify the appearance and 
behaviour of pivot tables on your dashboard tabs. A pivot table is a tabular 
representation of data that can automatically sort, count, total or give the 
average of data quickly creating un-weighted cross tabulations. 

The Pivot Table editor window consists of the following tabs; 

Option Description 

Data Allows you to define the data that 
will populate the pivot table. 

Total and Differences Allows you to define the 
appearance and behaviour of total 
and difference rows and columns 
for the pivot table. 

Appearance Allows you to specify settings that 
will govern the appearance of the 
pivot table. 

Numeric Format Allows you to specify the numeric 
format used to display numbers in 
the dashboard object 

Drill Down Allows you to add and define a drill 
down for the pivot table 
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Defining the data for a Pivot Table 

Follow the steps below to specify the data; 

1. First select the Query data set that you wish to base your dashboard 
object 

 
2. Select the calendar you wish to be used to derive any date groupings 

(such as year, period, week etc).  
 

3. If you wish to, press the filter button to apply a filter to your data set. 
Next, decide how you want to group your data, and select the 
appropriate option; 
 

4. Next, add dimensions () to the row and column groupings you require. 
You can do this by selecting the appropriate available column and 
pressing the add button to the left of the row(s) list or the add button 
to the left of the column(s) list, or simply dragging columns from the 
available columns list to the row(s) list or column(s) list. 
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5. If you wish to, you can change the way group values are grouped, 
sorted and displayed by selecting the group options button to open 
the group options window. 

 
6. Next, select which metrics you require as summary columns. 

 

 
7. For each summary column, select the summary operation you wish to 

be applied. Distinct count is the number of distinct values in the 
column for the group selected. If you select distinct sum, you will 
need to select a dimension to define the distinct values. Finally, if the 
column is calculated, rather than existing in the dataset, you will only 
be offered the summary type calculated.  
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Defining totals and differences for a pivot table 

The totals and differences tab of the pivot table dialog allows you to define 
the appearance and behaviour of total and difference rows and columns for 
the pivot table. 
 
Follow these steps to define the appearance totals for the pivot table: 
 

1. Check the appropriate checkboxes to display row and/or column 
totals as required. 

 
2. If required, change the label of the total row and columns. 

 
Difference columns display the difference between a column and the 
preceding column. Follow these steps to show difference columns: 
 

 
 

1. Select a column 
2. Select the type of difference you want to show. The options are; 

Option Description 

None No differences are shown 

Values The actual difference value is 
shown. 

Percentage The percentage difference is 
shown. 
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Defining the appearance for a Pivot Table 

The Pivot Table editor window Appearance tab allows you to specify settings 
that will govern the appearance of the pivot table. 

The available options are: 

• Enter a title for the pivot table. 

Defining the Numeric Format for a Pivot Table 

The Pivot Table editor window Numeric Format tab allows you to specify 
settings that will govern the formatting of numeric information of the pivot 
table. 

You can specify a different numeric format for each summary value in the 
pivot table. As such, you need to select which summary you are specifying 
the details for. 

 

Next, select the maximum number of decimal places you want to show. If 
your values are currency values, select force trailing zeros. 

 

Finally, if you require it, select a currency symbol (value that will be 
displayed before your numeric values). If the value you want is not in the 
list, select other and enter your desired value. You can also enter a number 
suffix, a string that will be displayed after numeric values. 
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Adding a Gauge 

The Gauge Editor window allows you to specify the appearance and 
behaviour of gauges that have been added to your dashboard tabs. 
 

 
The editor window consists of the following windows; 

Tab Description 

Data Allows you to define the data that will populate the 
gauge. 

Appearance Allows you to specify settings that will govern the 
appearance of the gauge. 

Numeric Format Allows you to specify the numeric format used to 
display numbers on the gauge. 

Colour Allows you to specify colours for the gauge 

Drill Down Allows you to add and define a drill down to the gauge 

Advanced Allows you to add advanced XML definitions to your 
gauge. 

 

Specifying Data for your Gauge 

The Gauge Definition window Data tab allows you to specify the data that 
will be used to render your gauge. 
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Follow the steps below to specify the data; 
 
First select the Query data set that you wish to base your dashboard object; 

 
If you wish to, press the filter button to apply a filter to your data set.  
  
Next, you need to define the value that the gauge will display. First, select 
the column that represents the value that will be displayed. Next select the 
summary operation that will be used to calculate the value for the gauge. 
Finally, if you want the values on the gauge to be displayed as a percentage, 
select the percentage button. ( ) 

 
 
If the gauge object you are defining supports colour ranges, you can choose 
to allow the minimum and maximum values for each colour range to be 
calculated automatically, or set manually. If you opt to allow the colour 
ranges to be automatically calculated, each colour range will represent 
exactly a third of the range for the whole gauge.  
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To define the range for the whole gauge (the minimum and maximum values 
that will be displayed on the range), first select the Range for the whole 
gauge option in the list of ranges. 

 
 Next we need to define a value for the minimum and maximum values. The 
value can be a fixed value, or a dynamic value derived from one of the 
columns in the data set.  
 
To set a range value to a fixed value, select Fixed Value, then enter the 
value. 
 
To set a range value to be dynamic, select the column, then the summary 
type that will be used to calculate the range value. 
 
Just be aware, if the value the gauge displays is smaller than the minimum 
value you have defined, or larger than the maximum value you have defined 
the range will be automatically extended to allow the value to be 
represented on the gauge. 
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Next, if the gauge object we are defining supports colour ranges, we can 
choose whether to show each colour range and define how it will appear. 

 

 To show or hide a particular colour range, select the colour range in the list 
of ranges and check or uncheck the Show this range option. 

The minimum and maximum values for a colour range can be a fixed value, 
or a dynamic value based on a percentage of the whole gauge range, or a 
summary calculation on a column in the data set.  

To set a colour range value to a fixed value, select Fixed Value, then enter 
the value. 

 To set a range value to be dynamic based on a percentage of the whole 
gauge range, select Percentage of Range, then enter the percentage value. 

 To set a range value to be dynamic based on a column, select the column, 
then the summary type that will be used to calculate the range value. 

  

mk:@MSITStore:C:/workdir/DATAPA/Help/DataPA.chm::/gauge_editor_data.htm#querydata
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Finally, select a colour for the colour range. 

 
 
If you are defining a Traffic Light gauge object, you can enter a label for each 
of the colour ranges. You can choose the display these labels rather than the 
value on the gauge. 

Defining the Appearance of the Gauge 

The Gauge Editor window Appearance tab allows you to specify the 
appearance of the gauge. Follow the steps below to specify the appearance 
of your gauge; 
  
First, select the type of gauge object you wish to display, enter a title and 
select whether or not you wish the value represented by the gauge to be 
added as a label to the gauge.  

 

Next, if your gauge object supports labels, choose whether you want the 
labels for the gauge shown inside the gauge, outside the gauge or not shown 
at all. 
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If your gauge object supports tick marks choose whether tick marks should 
be shown inside the gauge, outside the gauge or not at all. 

If your gauge object supports tick marks choose whether tick marks should 
be shown inside the gauge, outside the gauge or not at all. Next enter the 
number of major and minor tick marks, and the frequency of labels on the 
gauge.  

 
 
If you are defining a Traffic Light gauge you can choose to display range 
labels rather than the value on the gauge. You can also select whether to 
show the label or value below the gauge, inside the gauge or not at all. 

 

 

Defining Numeric Formats for a Gauge object 

The Gauge Editor window Numeric Format tab allows you to specify the 
numeric format used to display numbers in on the gauge. Follow the steps 
below to specify the numeric format on your gauge; 
  
First, select the maximum number of decimal places you want to show. If 
your values are currency values, select force trailing zeros. 

 
You can apply scaling to your numeric values in a gauge. Scaling provides 
notation for large values, so for instance 1340 can be displayed as 1.34K, 

mk:@MSITStore:C:/workdir/DATAPA/Help/DataPA.chm::/gauge_editor_data.htm#label
mk:@MSITStore:C:/workdir/DATAPA/Help/DataPA.chm::/gauge_editor_data.htm#label
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and 2345263 can be displayed as 2.35M. There are a number of scaling units 
pre-defined for you, however if these do not fit your requirements you can 
define your own. 

 

 

To define your own scaling units, select other from the scaling units list. Next 
supply a comer separated list for the scaling units and the scaling values. 
Each entry in the scaling units list will be displayed as a suffix to your 
values. Each entry in the scaling values represents the amount the value will 
be divided by from the previous scaling unit to achieve the display value.  

For instance, you could set your scaling units to 
"Thousands,Millions,Billions" and your scaling units to "1000,1000,1000". In 
this example, 1340 will be displayed as 1.34Thousands, and 2345263 will 
be displayed as 2.35Millions. 

If the scaling units list has one more entry than the scaling values, units will 
be given the first entry in the list as a suffix. For instance, for time scaling 
units, you could set your scaling units to "minutes,hours,days,weeks,years" 
and your scaling values to "60,24,7,52". 

If you require it select a currency symbol (value that will be displayed 
before your numeric values). If the value you want is not in the list, select 
other and enter your desired value. You can also enter a number suffix, a 
string that will be displayed after numeric values. 

 
 
Finally, if you wish to suppress the thousand separator for numbers, select 
the Suppress thousand separator check box. 
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Selecting Colours for your Gauge 

If your gauge supports colour ranges the screen allows you to change the 
colour for each colour range.  
 
To define colours for the colour ranges, select the colour range then press 
the button to choose the colour for this range.  
 
If your gauge does not support colour ranges, simply select the colour to be 
used when rendering your gauge. 



inmydata – creating dashboards 

 54 

 

Editing dashboard objects 
To edit a dashboard object in your dashboard, follow these steps: 
 

1. Select the dashboard object you want to edit in the tab. 
2. Press the Edit button in the Dashboard Objects group in the Edit 

Dashboard tab. 
3. Complete the required changes in the Dashboard Object Definition 

window. 

Moving dashboard objects 

You can move dashboard objects either within the tab they are currently 
displayed, or between the tabs in a dashboard.  
 
To move dashboard objects within a tab, follow these steps: 
 

1. Select that tab that contains the object you want to move.  
2. Press the Design Dashboard Tab button in the Dashboard Tab in the 

Edit Dashboard tab. 
3. Press and hold the tab header of the dashboard object you want to 

move. 
4. Drag the object over the appropriate drag icon (described in detail 

below).  
5. Release the left mouse button. 
6. Press the Preview Dashboard Tab button in the Dashboard Tab in the 

Edit Dashboard tab. 
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As you drag the object over the tab, two types of guide icon will appear. 
 

 
Guide icons around 
the edge of the tab 
allow you to place 
the new dashboard 
object against the 
left, top, right or 
bottom edge of the 
tab. 

 
 
When you drag the 
mouse over an 
existing object in 
the dashboard, 
guide icons appear 
that allow you to 
drop the new object 
to the left, top, right, 
bottom of the 
existing object, or 
stacked on top of 
the existing object. 
If objects are 
stacked, tabs will 
appear to allow the 
user to display each 
object. 

 

 

 

 

  
 
To move a dashboard object from one tab to another, follow these steps: 
 

1. Select the dashboard object in the tab. 
2. Press the Cut button in the Dashboard Objects group in the Edit 

Dashboard tab. 
3. Select the tab you want to move the dashboard object to. 
4. Press the Paste but button in the Dashboard Objects group in the Edit 

Dashboard tab. 
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Lesson 6 – Adding control panels and filtering data in your 
dashboard 

Introduction 

In this lesson you will learn what control panels are, and how to add them to 
your dashboards. You will also learn how to filter data in your dashboard. 

Learning Objectives 

When you complete this lesson you will be able to: 
 

• Add control panels to your dashboard. 

• Understand what control panel objects are available, and how to add 
them to your control panels. 

• Add filters to objects on your dashboards. 

• Add and edit filter conditions to filters. 

• Apply treeview filters to existing filters.  
 

Prerequisites 

Before you begin this lesson you should be able to: 

• Install the inmydata client applications. 

• Open the dashboard designer. 

• Understand the dashboard designer interface. 

• Create and open dashboards. 

• Add visualisations to your dashboard. 
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Managing control panels 

Control panels allow you to add titles, images, filter parameters, and web 
elements to a dashboard.  

Adding a control panel to a dashboard 

Follow these steps to add a control panel to your dashboard: 
 

1. Drag a control panel from the toolkit on to your dashboard, or select 
Control panel from the list that appears when you press the Add 
button in the Dashboard Objects group of the Edit Dashboard tab. 

2. Define the control panel selection panel settings in the Control Panel 
window (described in more detail below). 
 

Deleting a control panel from a dashboard 

To delete the control panel from a dashboard, follow these steps: 
 

1. Click on the control panel in the dashboard. 
2. Press the Delete button in the Dashboard Objects group of the Edit 

Dashboard tab. 
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Managing control panel objects 

Each control panel contains one or many control panel objects. The Control 
Panel window allows you to manage these objects on a particular control 
panel. 
 

 
The Control Panel window has a 
ribbon at the top of the window, 
and a work area at the bottom of the 
window.  
 

The ribbon has two tabs, the Panel 
tab that contains buttons to add, 
delete and move control panel 
objects in the control panel. The 
Objects tab allows you to edit 
properties of a single control panel 
object in the control panel. 

 
The work area displays the control panel you are currently working on, and 
allows you to select a single control panel object on the control panel. To 

select a control panel object on the control panel, simply press the left 
mouse button over the control panel object. The selected control panel 
object is highlighted in the work area. 
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The different control panel objects that you can add to a control panel are 
described in the table below: 
 

Object Type Description 

Title Allows you to add a text title to your control panel 
object. 

Filter Parameter Provides an object to input a filter value that can 
be used to filter objects on the dashboard. 

Calendar Variables Calendar variables are date-time period values 
that are defined against a specific dataset and can 
be used in filters and calculations 

Calculation 
Variables  

Calculation variables are values defined against a 
specific dataset that can be used in calculated 
columns in that dataset. For instance, you might 
define a calculation variable for a currency 
exchange rate, which is used to convert values 
between currencies.   

Image Allows you to add an image to the control panel. 

Web Element Allows you to add web elements to a dashboard 
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Adding a title to a control panel object 

Titles allow you to add a text title to your control panel object. To add a title 
to your control panel object follow these steps: 
 

1. Press the Title button in the Add group of the Panel tab. 
2. Enter the text you want to appear as your title in the Label dialog box 

and press OK. 
3. Select the style of the title using the style option in the Label group of 

the Objects tab. 

 

Adding filter parameters to the control panel 

Filter parameters provide an object to input a filter value that can be used to 
filter objects on the dashboard. Applying the filter to objects on a dashboard 
is described in detail in the Applying Filters to Objects section below. The 
different types of filter objects you can add to a control panel are described 
in the table below: 
 

Type Description 

Drop down 
list 

Allows the user to select a value from a pre-defined list 
of values.  

Date Picker Allows the user to select a date value. 

Slider A slider control allows the user to select a numeric value 
between a predefined minimum and maximum.  

Check Box Allows a user to select a true or false value. 

Text Allows the user to enter freeform text 

 

Follow these steps to add a filter parameter to the control panel: 
 

1. Press the Filter Parameter button in the Add group from the Panel tab. 
2. Select the type of object from the drop down list. 
3. Define the details of the object using the Object tab (described in 

more detail below). 
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Defining the details of a drop down list 

To define the details of a drop down list filter parameter, follow these steps: 
 

1. Press the Edit Text button of the Label group in the Objects tab, enter 
the text for the drop down list label and press OK. 

2. Modify the font and font appearance using the Label group of the 
Objects tab. 

3. Press the Drop Down Contents button in the Behaviour group of the 
Objects tab. 

4. Define the drop down list contents (described in more detail below) 
and press OK. 

 
You can define the contents of the drop down list using data returned from a 
query, or manually. Both methods are described below. 
 
To define the contents of the drop down list using data returned from a 
query, follow these steps: 
 

1. Select the option to populate the drop down list from a query, then 
select the query data set you want the values to be drawn from. 

2. Select a calendar to use to derive date groupings.  
3. If you want to filter the query data set (perhaps to filter the contents 

based on another filter parameter), select the filter button to open 
the Define Filter Condition window to allow you to define the filter. 

 
4. Select the column you want to use to build a list of values to be 

displayed in the drop down list.  
5. If the column is a date field, select which time interval you want to be 

used to build the display values. 
6. You may wish to use a value from column other than the display 

column in your filter condition. To define a different column as the 
filter parameter value, select the use a different column check box 
and select the column you want to use. 

7. Finally, select whether you want the values sorted (by the display 
value, rather than shown in the original order), whether you want to 
ignore duplicate items, and whether you want to include an option for 
all (if all is selected any filter condition based on this filter parameter 
will be ignored).(NB. if you have opted to use different columns for 
the display and value columns, two items are only considered 
duplicate if both columns have the same value). 
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To define the contents of a drop down list manually, follow these steps: 
 

1. Select the manual option, 
then repeatedly enter an 
item and press Add to add it 
to the list. 

2. To change the order of 
values in the list, select the 
value, then press the green 
up or down arrows to move 
its position in the list. 

3. To delete an item from the 
list, select it in the list then 
press the Delete key. 

4. When all items are in the 
list, press OK.  

Defining the details of a date picker 

Follow these steps to define the details of a date picker: 
 

1. Press the Edit Text button of the Label group in the Objects tab, enter 
the text for the date picker label and press OK. 

2. Modify the font and font appearance using the Label group of the 
Objects tab. 

Defining the details of a slider 

Follow these steps to define the details of a slider: 
 

1. Press the Edit Text button of the Label group in the Objects tab, enter 
the text for the slider label and press OK. 

2. Modify the font and font appearance using the Label group of the 
Objects tab. 

3. Press the Slider Scale button in the Behaviour group of the Objects tab. 
4. Define the slider scale (described in more detail below). 
5. Define the numeric format (described in more details below) and 

press OK. 
 
There are two ways you can define the slider scale, using data returned from 
a query of manually entering the values. Both of these methods are 
described in details below. 
 
To define the scale of the slider using data returned from a query, follow 
these steps: 
 

1. Select the set range of the slider from the minimum and maximum 
values of a column returned by a query check box. 
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2. Select the query data set, and the column you wish to use to calculate 
the range. 

Finally, select whether the slider should show labels and major and minor 
tick marks. 
 
To define the scale of the slider manually, follow these steps: 
 

1. Select the set range of the slider manually check box. 
2. Enter a minimum and maximum value for the scale. 
3. Finally, select whether the slider should show labels and major and 

minor tick marks. 
 

 
To define the numeric format for a slider, follow these steps: 
 

1. Select the Numeric Format tab of the Slider Properties window. 
2. Select the maximum number of decimal places you want to show. 
3. Select whether you want to force trailing zero (for instance, the 

values are currency and you always want two values after the decimal 
point). 

4. Decide what scaling units to apply to your numeric values on the 
slider. Scaling provides notation for large values, so for instance 1340 
can be displayed as 1.34K, and 2345263 can be displayed as 2.35M. 
There are a number of scaling units pre-defined for you, however if 
these do not fit your requirements you can define your own. 

5. To define your own scaling units, select other from the scaling units 
list. Next supply a comer separated list for the scaling units and the 
scaling values.  

6. If required, select a currency symbol (value that will be displayed 
before your numeric values). If the value you want is not in the list, 
select other and enter your desired value. You can also enter a 
number suffix, a string that will be displayed after numeric values. 

Defining the details of a check box 

Follow these steps to define the details of a check box: 
 

1. Press the Edit Text button of the Label group in the Objects tab, enter 
the text for the check box label and press OK. 

2. Modify the font and font appearance using the Label group of the 
Objects tab. 
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Adding calendar variables to your control panel 

Follow these steps to add a calendar variable to your control panel: 
 

1. Press the Calendar Variable button on the control panel editor Panel 
tab to open the calendar variable dialog. 

2. Select the dataset the calendar variable belongs to 
3. Select the calendar to be used when deriving date values from 

calendar periods 
4. Select the calendar variable, and press OK 

 

Adding calculation variables to your control panel 

Follow these steps to add a calendar variable to your control panel: 
 

1. Press the Calculation Variable button on the control panel editor 
Panel tab to open the calculation variable dialog. 

2. Select the dataset the calculation variable belongs to 
3. Select the calculation variable, and press OK 
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Moving control panel objects on a control panel 

To move a control panel item up or down in the control panel, follow these 
steps: 
 

1. Select the control panel object in the work area of the Control Panel 
window. 

2. Press the Move Up or Move Down button in the Edit group of the Panel 
tab in the ribbon. 

Deleting control panel objects 

To remove a control panel object from a control panel, follow these steps: 
 

1. Select the control panel object in the work area of the Control Panel 
window. 

2. Press the Delete button in the Edit group of the Panel tab in the 
ribbon. 

Previewing a control panel  

The Preview button in the Appearance group of the Panel tab removes the 
selection highlight from the selected control panel object in the work area. 
This means the control panel in the work area appears exactly as it will in 
the dashboard. 
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Applying filters to objects 

Wherever you can select a query data set to apply to an object on the 

dashboard, you can also apply a filter by pressing the data filter button ( ). 
Filters can be static, for instance if you want to create a chart that shows 
orders for a specific country, or linked to a filter parameter or tree view 
panel, in which case the user can change the filter dynamically by changing 
the selection in objects on the dashboard.  
 
There are two ways you can define a filter for an object on the dashboard, by 
using the filter builder or by assigning a tree view selection panel. Each of 
the three methods is described in detail below. 

Using the filter builder 

To define a filter using the filter builder, follow these steps: 
 

1. Select the Filter Builder tab. 
2. Press Add to open the define filter condition window and create a 

new condition (described in more detail below). 
3. Repeatedly add conditions until your filter is complete 
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4. To group conditions, select multiple conditions and press the Group 
button. 

 
5. Press OK to finish. 

 
The Define Filter Condition window allows you to define three types of 
condition, a simple fixed value condition, a list of fixed values condition or a 
filter parameter condition. Each is described in more detail below. 
 
To define a simple fixed value condition, follow these steps: 
 

1. Select the logical operator (and/or) 
2. Select the column you want to apply the condition to. 
3. Select the operator to use to compare the column. 
4. Select or enter the value to compare the column to. 
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To define a list of fixed values condition, follow these steps: 
 

1. Select the logical operator (and/or) 
2. Select the column you want to apply the condition to. 
3. Select the operator to use to compare the column. 
4. Press the list button 
5. Repeatedly select or enter a value and press Add to add it to the list. 

 

 
 

To define a filter parameter condition, follow these steps: 
 

1. Select the logical operator (and/or) 
2. Select the column you want to apply the condition to. 
3. Select the operator to use to compare the column 

4. Press the filter parameter button ( ). 
5. Select the filter parameter you want to use. 

 
 
The filter parameter list may also contain values linked to the user. For more 
details, contact your administrator. If you create a condition that is linked to 
a filter parameter, and the filter parameter object is deleted from the 
dashboard, the condition is changed to be a fixed value condition with the 
fixed value being the last known value of the filter parameter.  
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Applying a tree view filter panel filter 

As we described earlier in this lesson, tree view filters can be applied to 
objects from the Tree View Filter Panel Editor window. We can also apply tree 
view filters to objects from the Define the data Filter window. If an 
appropriate tree view filter panel (one for which all the columns in the tree 
view are represented in the objects data set) exists, the Tree View Selection 
Panel tab will be offered in the Define the data Filter window. Follow these 
steps to apply a tree view filter to an object: 
 

1. Selection Panel tab. 
2. Select the treeview in the available list you wish to apply  
3. Press the add button to move the treeview to the selected list 
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Lesson 6 – Publishing, saving and managing dashboards 

Introduction 

In this lesson you will learn how to save a dashboard locally to disk and 
publish it to the server. You will also learn how to manage dashboards 
published to the server.  

Learning Objectives 

When you complete this lesson you will understand: 
 

• How to save a dashboard locally to disk. 

• How to publish a dashboard to the server. 

• How to modify a dashboard published to the server. 

• How to delete a dashboard published to the server. 
 

Prerequisites 

Before you begin this lesson you should be able to: 

• Install the inmydata client applications. 

• Open the dashboard designer. 

• Understand the dashboard designer interface. 

• Create and open dashboards.  

                   

        
                                
          



inmydata – creating dashboards 

 71 

 
 

 

Saving a dashboard 

Saving a dashboard saves the definitions of the tabs and dashboard objects 
in a dashboard. There is no data saved with the dashboard. Follow these 
steps to save a dashboard: 
 

1. Select Save or Save As from the File menu on the ribbon. 
2. If prompted, enter the name of the file you wish to save the 

dashboard as.  
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Publishing a Dashboard 

 
To publish a dashboard, follow these steps: 
 

1. Select Properties from the File menu on the ribbon. 
2. Enter a name, description and select a category to publish your 

dashboard to, then press OK.  
3. Select Publish from the File menu on the ribbon. 

Editing a published dashboard 

To edit a published dashboard, follow these steps: 
 

1. Open the dashboard from the server 
2. Make your required changes 
3. Publish your dashboard. 

 
NB: Publishing a dashboard that already exists on the server will overwrite 
the existing version, applying any changes you have made. If you want to 
publish a second copy of the dashboard, save a copy first by selecting Save 
As from the File menu of the ribbon. This gives the dashboard a new identity. 
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Deleting a published dashboard 

To delete a published dashboard, follow these steps: 
 

1. Click on the Open web button on the Application Settings tab of the 
ribbon. 
 

 
 

2. Log in 
3. Select the category the dashboard was published to 
4. Press the delete button on the tab for the dashboard you want to 

delete.  
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Appendix A – Year on year comparisons with summary 
calculations and calendar variables 

Introduction 

In this lesson you will learn how to use summary calculations to easily create 
year on year comparisons. You will also learn how to use calendar variables 
to allow users to easily compare different years.  

Learning Objectives 

When you complete this lesson, you will understand: 
 

• The concept of summary calculations. 

• How to create summary calculations. 

• How to use summary calculations in a dashboard or visualisation. 

• How to create calendar variables and apply them to filters and 
summary calculation. 

 

Prerequisites 

Before you begin this lesson you should be able to: 

• Access the data administration screens and edit subjects. 

• Create visualisations. 

• Create and open dashboards. 

• Add and edit filters to dashboard objects 

• Add control panels to a dashboard 
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Understanding summary calculations 

 
When we add a metric to a dashboard or visualisation, the value will be 
calculated by applying some summary operation to each row that matches 
the dimensions displayed. For instance, in the chart below, the Sales Value is 
calculated by summing the metric Sales Value in every row that matches a 
particular store. A filter is applied to the chart so we only see sales for the 
current year. 
 

  
However,   ’                                                              
current year with sales in the same stores last year. Summary calculations 
allow us to achieve this by creating metrics that have an implicit filter 
applied to them.  
 

For instance, we could create two new metrics Sales TY, which would always 
only total sales in the current year, and Sales LY which would always only 
total sales in the previous year.  
 
The chart below has no filters applied, however there are two implicit filters 
applied in the two metrics Sales TY and Sales LY 
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Creating summary calculations 

 
To create a summary calculation for Sales TY, follow these steps: 
 

1. Open the settings screen from the user menu (you will need to be an 
administrator in your tenant to have access to this screen). 

 
2. Select Subjects in the left-hand tab, then find the subject you want to 

add the summary calculations to and press the edit button. 

 
3. Press the Add metric button 
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4. Select the option Create a new metric in the subject from a new 
calculated column 

5. Enter a name the column (  ’       Sales LY) 
6. Select Summary Calculation as the type of calculation 
7. Select the column we want to sum (w ’          Sales Value) 
8. Select the summary operation (w ’       Sum) 
9. Define the filter to apply to this summary column. For our Sales LY 

           ’                       
a. Press the Add Filter Condition button to add a filter condition 

 
b. Select Date as the column to filter on 
c. Select >= as the operator 
d. Under the Value heading, select Calendar Value 
e. Select Start of this year as of 1 year ago for the calendar value 

options 
f. Press OK 

 
g. Repeat steps a and b above to add a second condition. 

Select <= as the operator 
h. Under the Value heading, select Calendar Value 
i. Select End of this year as of 1 year ago for the calendar value 

options 
j. Press OK 

 

Using summary calculations 

                                               ’                              
and dashboards as any other metric. The implicit filter is automatically 
applied to any figure where the summary calculation is used. 
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Understanding Calendar Variables 

It is a common requirement to build dashboards that display year on year 
comparisons. Normally we will compare the current year to the previous 
year. However, when we have periods of unusual trading, perhaps because 
of a global pandemic or a structural change in the organisation, we may wish 
to allow the user to easily change the years that are being compared. 
Calendar variables allow us to display selection lists on dashboards that 
allow users to easily specify which calendar periods are used in filters.  

Creating Calendar Variables 

To create a calendar variable, follow these steps: 
 

1. Open the settings screen from the user menu (you will need to be an 
administrator in your tenant to have access to this screen). 
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2. Select Subjects in the left-hand tab, then find the subject you want to 
add the calendar variable to and press the edit button. 

 
3. Select the Calendar Variables tab, then press the add button to add a 

calendar variable. 

 
4. Enter the name of the calendar variable 
5. Select which financial periods you wish the user to be able to check 
6. Select the default value for the calendar variable 

 
7. Press OK 
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Adding Calendar Variables to a Dashboard 

To add a calendar variable to a dashboard, follow these steps. 
1. Add or edit a control panel to on a dashboard. 
2. Click the Calendar Variable button to add a calendar variable to the 

control panel. 

 
3. Select the subject that contains the Calendar Variable you want to 

add. 
4. Select the calendar that will be used to define the periods 

represented in the Calendar Variable 
5. Select the Calendar Variable you wish to add to the dashboard. 

 
6. Press OK 
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Using Calendar Variables in a filter 

Once a calendar variable has been added to a subject, it can be used in any 
filter that uses a date column in that subject. The calendar variable can then 
be used to change the applied filter according to the financial period 
selected in the calendar variable drop down.  
 
To apply a calendar variable to a filter, do the following. 
 

1. Edit the filter on a dashboard object. 
2. Edit or add a filter condition on a date column. 
3. Select Calendar Variable as the type of value 
4. Select as of calendar variable [Calendar Variable Name] 

 

Using Calendar Variables in a Summary Calculation 

To apply a calendar variable to a summary calculation, do the following. 
 

1. Edit the filter on a summary column. 
2. Edit or add a filter condition on a date column. 
3. Select Calendar Variable as the type of value 
4. Select as of calendar variable [Calendar Variable Name] 

 

 
 


